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Abstract 

The rapid evolution of e-learning models increases the number of decisions that have to 

be made when developing web-based learning systems. ADISA is a web-based system 

for a project team designing a  e-learning system while working on the web.  It is based 

on the MISA method that defines 35 main tasks through which the user produces the 

design specifications of a learning system, describing knowledge, skills and 

competencies, learning scenarios, activities and resources, learning materials, and finally, 

the delivery processes. The innovation in MISA and ADISA is three-fold. a) A key 

component of ADISA is its object-oriented knowledge modeling approach sustained by a 

graphic model editor. b) The processes embedded in the method encompass all the 

dimensions of a telelearning system. c) Software engineering principles are integrated to 

support systemic design by the project team. The paper describes both the pedagogical 

and technical aspects of the ADISA system. 

1. Principles for instructional engineering 

We first define instructional engineering as a method for the analysis, design, development and delivery 

planning of computer-based learning systems, integrating concepts, processes and principles of 

instructional design, software engineering and cognitive modeling.  

There is a growing need for such a methodology because the advances in instructional technologies entail a 

large set of interrelated decisions to make when we build a telelearning system. What kind of telelearning 

delivery model or what mix of models do we need? Will we support learners and trainers anywhere, 

anytime, at any pace? What kind of learning scenarios is useful for a course? Should these scenarios be 

predefined, propose several learning paths or be learner-constructed? Which actors will interact at delivery 

time, what are their roles, what resources do they need? What kind of interactivity or collaboration should 

be included in the system? Will we use a multimedia or a plurimedia approach? How are we to manage the 

distributed resources? What kind of learning object standards will be used? How can we support 

interoperability and scalability of the telelearning system? How do we take in account the technological 

diversity between groups of users within the target population? How can we promote reusability, 

sustainability and affordability of the web-based learning system we are building? 

In light of these questions, instructional design (ID) methodology has a more important role to play than 

before, but we also need a new generation of ID methods, based on the following principles: 

 Information system approach. A Telelearning system is an information system, a complex array of 

software tools, digitized documents and communication services. The artisan-like construction of web 

based materials and the use of simplistic authoring tools is totally insufficient. Similar to the evolution 

in software engineering, systematic design processes must support telelearning systems design. 

 Knowledge based design. The actual emphasis on knowledge management in organizations leads to the 

recognition of knowledge and higher order skills (competencies) as major training goals, as opposed to 

simple information acquisition.  Knowledge engineering is now a well-established methodology rooted 
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in AI and expert systems research and practice. Knowledge modeling methods and tools should be at 

the center of the new ID methodology, in relation to the knowledge management processes. 

 Multi-agent systems.  To be called multi-agent, a system must satisfy four properties Sycara 1998 . 

First, the agents, components of the system are situated in one environment. Second, they are 

autonomous, they control their actions and states. Third, they are adaptive, reacting to change in a 

flexible way, taking goal-driven initiatives, learning from interactions with other agents. Finally, they 

are sociable, collaborating and coordinating themselves with users or other software agents. Multi-

agent systems offer a good way to model a telelearning system to help define the actors, their functions 

and roles, and also their interactions as a society of agents.  

 Plurimedia material and macro-design. A plurimedia material is a set of large grained digitized files 

delivered on different supports: print, CD-ROMs, DVDs, web servers, etc. The emphasis on fine 

grained, closely structured multimedia, will decrease as designers prefer to interoperate existing 

videos, textbooks, courseware materials waiting to be digitized. Instructional engineering shifts the 

attention from multimedia micro-design to macro-design of learning scenarios integrating plurimedia 

materials reusing many  available corporate documents and tools. 

 Constructivist pedagogy based on projects, problem solving and process-centered environments is 

necessary to promote the acquisition of higher skills & competencies, but it is difficult to encompass in  

an ID method. This can be done by proposing 

problem/project based scenarios where the learner 

will need to use analyzing, synthesizing or 

evaluating skills. Theses processes will, in turn, 

orient the search for “just-in-time” and situated 

information instead of “just-in-case information”, 

wasting a lot of time transmitting masses of 

information to be memorize, understood and applied 

at a later occasion.  Figure 1 compares these two 

kind of instructional strategies.  
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Figure 1 – Hierarchy of skills and information 

 2.  Outline of the MISA instructional engineering method 

Based on the principles summarized above, we have built, during the past eight years, a new instructional 

engineering method called MISA. The first version of the method was completed in 1994. It was embedded 

in a computerized support system for designers called AGD Paquette et al 1994, 99 .  
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Figure 2 - Learning system engineering concepts 
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The MISA instructional engineering method is based on the concept of a learning system presented in 

figure 2, where ovals represent design processes and rectangles their inputs and outputs. MISA 4.0 helps 

design a learning system through 35 tasks (shown in table 1) producing 35 main deliverables called 

documentation elements (DE). The method unfolds through six well-defined phases, the first digit of a task 

number identifying the phase. Except for the initial phase of instructional problem definition, these phases 

integrate four blueprints or axis (identified by the second digit): 1-knowledge, 2-pedagogy, 3- materials and 

4-delivery. Table 1 shows the content of each of theses four blueprints. 

 

Knowledge Blueprint Instructional Blueprint 

210 Knowledge modeling principles 220 Instructional principles 
212 Knowledge model 222 Learning events network 
214 Target competencies 224 Learning units properties 
310 Learning unit content 320 Instructional scenarios 
410 Learning instrument content 322 Learning activities properties 
610 Knowledge and comptency management 420 Learning instruments properties 

620 Actors and group management 

Learning Materials Blueprint Delivery Blueprint 

230 Media principles 240 Delivery principles 
330 Development infrastructure 242 Cost-benefit analysis 
430 Learning mateirials list 340 Delivery planning 
432 Learning materials models 440 Delivery models 
434 Media elements 442 Actors and user’s materials 
436 Source documents 444 Tools and telecommunication 
630 Learning system and ressource management 446 Services and delivery locations 

540 Assessment planning 
542 Revision decisions log 
640 Maintenance and quality management 

Problem definition 

108 Reference documents 
100 Organization’s training system 

102 Training  objectives 
104 Target populations 

106 Actual situation 

 

Table 1 – Main instructional engineering tasks in the MISA 4.0 method 

Similar to software engineering methods, each blueprint starts with the statement of orientation principles.  

Each of these sets of principles in 210, 220, 230 and 240 are guidelines that the design team establishes to 

coordinate their work in a coherent way. These principles establish communication between team members, 

promote goal directed behavior and help in consistency maintenance throughout the design process. 

In each of the four axis, a central task is to build one or more graphical models. These models are the 

backbone of the method. We build a structured view of the target knowledge and skills (212), followed by 

their distributions into learning units (310) and learning instruments (410). These models are described 

using a knowledge modeling technique called MOT Paquette, 1996 , where four types of knowledge 

objects and seven types of links are available to formalizing a model. In the instructional axis, process 

modeling is used to represent the structure of the learning events at the course or program level (DE 222), 

as well as the learning scenarios describing the activities in a learning unit (DE 320). In the learning 

material axis, we model (DE 432) for example a web site or an hypermedia software, showing the media 

components, their interrelations through hyperlinks, the media templates and the source documents to be 

displayed in the material. Finally, in the delivery axis, we model (DE 440) the actors, their roles, their 

interactions, their input resources and their productions. 

Most of the other tasks in MISA describe properties of the objects contained in the models of the axis 

where they belong. For example, we identify target competencies (DE 214) related to objects in the 

knowledge model. Learning activities (DE 322) and learning instruments (DE 420) are properties of the 

objects in the learning scenarios. Source documents (DE 436) describes objects in the learning material 

models and, finally, tools and telecommunication services (DE 444) describe objects in the delivery 

models. 

MISA 4.0 has been redesigned while building a web-based computer system called ADISA, a distributed 

system for the instructional engineering of learning environments. We will now describe this system. 
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 3- ADISA – A web-based workbench for instructional engineering 

ADISA is a distributed system developed to enhance the performance level of instructional designers, and 

specifically to assist teams who create Internet-based distance courses or who use sophisticated multimedia 

technology. This system includes productivity enhancement tools that reduce effort and cost of 

instructional engineering while maintaining quality consistency and control throughout the various 

components of a learning system. MOT, an object-oriented knowledge model editor, is a key component of 

ADISA, making it the first complete knowledge based instructional design tool. 

ADISA integrates a large set of educational knowledge embedded including 17 typologies of educational 

concepts of the MISA 4.0 method integrated menus offering various options to the designers to built some 

of the DEs. In the case of knowledge models types, a library of models can be made available to the 

designer as a starting point and later modified in order to adapt to the specifics of the learning situation. 

As shown on Figure 3, ADISA is accessible through a Web browser. The left part of the screen gives 

access to the tools supporting MISA tasks through a table corresponding to the 35 documentation elements 

of the MISA method. The right part of the screen displays a tool allowing to build the selected 

documentation element. Here the MOT graphic modeling tool enables the designer to build the Learning 

Event Network (DE 222) which is a graph representing the structure of a course subdivided here into seven 

modules or learning units. Other DEs are DHTML forms describing properties of objects in such a model.  

 

Figure 3 – ADISA screen for DE –222 to build the Learning Event Network 

Besides the DE card display, the four menus on the left side of the screen give access to ADISA’s 

commands. The Project menu allows to create, open, duplicate or delete a design project. It also helps to 

manage the rights of access, allowing members of a team to work together on various elements of 

documentation and integrate their work. ADISA is the first instructional engineering system completely on 

the Internet allowing both online and off-line design specifications stored on either a server or a local disk 

drive. On and off-line copies are synchronized using the import feature in the Project menu. 
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The Edit menu offers different options to build the selected DE. One can save it and add to it user defined 

notes and tables of additional properties. DEs can be marked as completed or validated.  A display of the 

DE can be shown and archived, allowing different versions to be saved for future production of reports. 

The Reports menu allows to regroup the various versions of the DEs to create reports by phase, by axis, by 

author or any other criterion chosen by the designer.  It helps create the report structure, order its various 

constituents and print the report. 

The Environment menu offers a search function operating on the set of DEs (DHTML forms or MOT 

graphs), a complete on-line help system and some user options. It allows the download of the ADISA 

structure from the server to a client station for " off-line " work. It finally gives access to a navigation 

function, accessible through any Web browser, allowing a designer or an external observer to view and 

annotate the DEs to suggest improvements to the project team, without altering the initial documents 

On the technical side, ADISA uses the basic features of Windows and Internet Explorer, especially 

dynamic HTML forms which modify themselves according to the user’s choices. Once saved, DHTML 

forms, as well as MOT graphic models, are stored as XML files. This method allows the propagation of 

data between the DEs, an integrated search function for keywords in graphs and forms, as well as the 

communication with various types of databases and other systems such as authoring tools or learning 

management systems. The high graphic quality of the workbench provides a global and structured view of 

the learning objects facilitating the design process. The integration of tools in the workbench avoids the 

transfer of data, from one tool to another, thus saving time while preventing transcription errors or 

inconsistencies between related decisions. 

4. Data propagation in the workbench 

Data saved by the user from a DE form or a MOT model can be passed on to another DE in various ways 

Figure 4 shows the DHTML form of DE 224, allowing the designer to describe the properties for each of 

the learning units defined in a learning event network such as the one in Figure 3. 

 

Figure 4– Example of data propagation to a DHTML form in ADISA 
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The first line on this DE 224 form holds the name of the learning unit. It is selected by the designer in a list 

of learning units read from the XML file saved from the graph constructed in DE 222. It is an example of 

automatic data propagation between two documentation elements and so are the lines describing target 

populations of a learning unit. This time, the XML file from DE 104 is read for the names of the target 

populations; here IAO and ITIE representing students registered in two programs. 

Still on figure 4, we illustrate a non-automatic form of propagation. When the graph of the instructional 

scenario of a learning unit is built in DE 320, it can be displayed in a help window assisting the designer 

selecting, in DE 224, the type of scenario for this learning unit, for example, the type “tutorial with multiple 

choice” and “learner controlled pace”. This type of propagation helps the designer to check if the graph of 

the scenario corresponds to its description within DE 224. 

ADISA tries to create a balance between automatic propagation of data and the user controlled propagation. 

Automatic propagation is convenient, because the user does not have to re-enter data already created in 

another DE. Without the automatic propagation, the use of the method would be too often tedious. On the 

other hand automatic propagation implies more difficult teamwork, because of the possible conflicts 

between two designers, one working to change data on which the other one bases himself to build another 

DE. This situation would then force designers to work in a sequential manner rather than in parallel, which 

might not be ideal. 

Furthermore in many cases, automatic propagation is not desirable when one user is placed to make the 

best choices. For example, an important task of the design method consists in regrouping all the 

instruments appearing in the learning units, in a certain number of learning materials. The Content Expert is 

best placed to this task. 

 

Figure 5 – Data propagation organized to support the designer’s decisions 

To help the designer in this task, ADISA supplies a table illustrated on figure 5. Here, the system regroups 

instruments appearing in instructional scenarios (DE 320) and lists them as rows of the table. Columns 

represent the materials to be built, defined in DE 430. The interface on figure 5 allow the designer to decide 

which instruments will be regrouped and whether put on to one or several formats forming different types 

of material packages, just by checking the corresponding cells. 
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If another designer, working on a scenario in DE 320 decides to change the instruments serving as inputs to 

some of the activities, these changes will be announced to the designer in figure 5, so that s/he can interact 

with this colleague and complete the task while keeping the overall blueprint consistent. 

Conclusion 

In summary, ADISA  is a sophisticated set of tools linked together to address, if needed, the full complexity 

of instructional engineering. In most cases, a team of designers will use only a part of the system but the 

interrelations between DEs is always made available in the integrated help system and by alerts when a task 

needs a previous one to be completed. 

To keep the system as flexible as possible, while giving essential support to a team of designers, we have 

design three kinds of data propagation between instructional engineering tasks. 

 Automatic propagation is done by the system without user intervention, information in a source DE is 

transmitted to a target DE to be displayed in some fields of its DHTML form.  

 Source propagation consists in transmitting information from on or more sources in some DEs to a 

target DE where the user will select the information to be integrated in this DE. 

 Information propagation simply displays information from a source DE that is particularly useful to 

build a target DE, the user remaining free to use this information or not. 

ADISA is the first general instructional design support system solidly rooted in educational research, in 

knowledge engineering as well as software engineering principles. Further more, in all the 35 

documentation elements (DE), the corresponding tools output learning objects description as XML files, 

thus providing an extensive set of meta-data that can be used for interoperability. This metadata is 

compliant with the ongoing efforts to create international standards such as IMS, IEEE, ARIADNE, AICC, 

SCORM or CANCORE. 

Work is on-going at the LICEF research center and its associated company, Cogigraph Technology, to link 

ADISA to web based material production tools and delivery platforms for distance education. Meanwhile, 

the method and the tools are being applied in a number of projects and organizations for the design of e-

learning environments. 
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